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ABSTRACT 
 

Failures of glacial lake dams can cause outburst floods and represents a serious hazard. The 

potential danger of outburst floods depends on various factors like the lake’s area and 

volume, glacier area change, morphometry of the glacier and its surrounding moraines and 

valley, and glacier velocity. Remote sensing offers an efficient tool for displacement 

calculations and risk assessment of the identification of potentially dangerous glacial lakes 

(PDGLs) and is especially helpful for remote mountainous areas. 

In this study we will study about the change in number of the glacial lakes and the area of 

those lakes in the Sikkim Himalayan region with the help of remote sensing and Arc GIS. 
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CHAPTER 1 

INTRODUCTION 
 

Glaciers are situated in the most famous and remote regions over Earth surface. These are 

enormous assortments of ice and compacted snow which gradually streams under the activity 

of gravity. Of the most part of the glaciers, it exists mainly over land surface while some 

parts are discovered exclusively over sea water too. Presence of ice sheet and ice snow is 

constrained by two geographic factors. One of them is high elevations and the other is high 

scope
[1]

. Antarctic ice sheet (13.5 million km
2
) is situated in high southern most part. 

Greenland (2 million km
2
) is the largest ice sheet in the northern most part of the earth. Sub 

polar to polar areas are assessed to contain 500,000 km
2
 of glacier and snow

[1]
. The figure 

below demonstrates the heterogeneous spatial dissemination of glacier everywhere 

throughout the Earth. High altitude snow-capped glacier in Hindu Kush Himalaya, Kunlun 

Shan, Pamir and Tien Shan mountain reaches are regularly named as the water towers of the 

planet.
[2]

 

. 

                                 

Figure 1.1 Global Glacier Inventory (https://nsidc.org/data/glacier_inventory/) 

https://nsidc.org/data/glacier_inventory/
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The figure above demonstrates the present century dissemination of glacier and snow over 

the world. Icy masses are a basic piece of the common hydrological cycle. The water 

vanished from the lakes, seas, ocean, streams and other water bodies when gather in 

environment at exceptionally low temperature result into the arrangement of snowflake or 

snow
[2]

. This snow experiences the procedure of glaciation to frame firm fundamentally 

solidified type of Glacier ice. The liquefy water from ice sheet ice in the long run streams into 

sea and in the course control the vitality parity of Earth. Himalayan icy masses framework for 

example has huge effect on atmosphere of the sub-landmass. It has been accounted for in 

IPCC report 2007 that southern Asia would have been 12°C without Himalayas.
[3]

 

Major reasons to study glacier is that the glaciers are the fascinating elements of mother 

Earth. Glaciers are key indicator of climate change, and have always attracted scientists to 

study them. Academic reasons for studying glaciers are perhaps closely related to socially 

significant ones. 

Ice sheets spread around 10 percent of the Earth, during the last ice age they secured one third 

of the Earth's surface. Investigation of such a huge bit of our planet can't be dismissed. Icy 

mass ice is the biggest repository of new water on the planet, putting away an expected 75 

percent of the world's crisp water supply.
[3]

 As indicated by U.S. Land study greatest of the 

polar ice tops, Antarctica glaciers are around 40 million years of age. This normal legacy of 

our own is assessed to contain around 29 million cubic kilometers of ice. 

The Himalayan icy masses frameworks are most elevated of the icy masses present 

everywhere throughout the world. The word Himalaya is gotten from two Sanskrit words, - 

'Howdy mama' which means snow, and 'a-la-ya' which means dwelling place; it implies The 

Abode of Snow. This is the home of the wellspring of perfect and unadulterated water for 

right around 40 percent of the Earth's populace possessing Indian sub-mainland (UNEP, 

2004. Monetary significance of icy mass lies in the way that ice sheets are potential hotspot 

for drinking water and water system. Streams with their starting point in mountain reaches 

encompassing Tibetan Plateau involve the biggest stream run-off from a specific area on the 

planet. Himalaya is the most youthful of all the mountain ranges and goes back their 

beginning from Tethys Ocean. Overflow from the Himalayan range is in this manner wealthy 

in minerals and natural mixes which consistently renew richness of the outwash fields. People 

have shrewdly restrained the capability of icy mass dissolve water for the most broadly 

utilized financial ware, control. Hydropower plants create power by the fundamental rule of 
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electromagnetism. The potential vitality of the put away water in the repository is changed 

over into electric vitality. Alone in India Hydropower plants add to 37,367.4 MW of power 

age which relate to 21.53% of aggregate control utilization of the nation.
[4] 

A wide range of sorts of plant and creature species are found over the whole Himalayan 

mountain belt are jeopardized. Himalaya is characteristic territory to many imperilled 

creature species like Snow panther, Musk Deer, Himalayan Black Bear and some more. 

India is a nation of social ceremonies and convictions. Individuals in India venerate nature 

and its endowments. Himalaya overall, a few of its pinnacles and its precipitous lakes are 

viewed as sacrosanct and what's more, revered. 

1.1 GLOF- A GLACIER HAZARD 

Because of quick rate of liquefaction of ice and snow conceivably brought knowledge about  

a dangerous atmospheric disaster in which a large portion of the Himalayan ice sheets have 

withdrawn abandoning various frosty lakes.
[5]

 Glacial lake is characterized as water mass 

existing in an adequate sum and stretching out with a free surface in, under, next to, or 

potentially before an icy mass and beginning from icy mass exercises as well as withdrawing 

procedures of an ice sheet. IPCC in 2007 announced that with the expansion of temperature 

on Himalayan district between 1 to 6°C by 2100 the current inclusion of frosty ice and snow 

would diminish between 43 to 81 percent. Himalayan icy masses could shrivel from its 

present degree of 500,000 km
2
 to 100,000 km

2
 by 2030 deserting a lot progressively frosty 

lake in future.
[5]

 

Burst or unexpected release of enormous volumes of water alongside trash from these lakes 

causes frigid lake upheaval floods (GLOFs) in valley downstream causing enormous harm to 

foundation (like dams, streets, neighbourhoods, ranches and so on), common assets (like 

woodlands), fauna and human life. So there is a solid need to screen these lakes for their 

arrangement, development and weakness. 

1.2 RS & GIS IN GLOF STUDY 

Himalayan elevated ice sheets have their snow line over 3800 meters structure m.s.l. 

Geographical investigation of ice sheets in this area accordingly is exceptionally troublesome 

considering the actuality that land field studies are risky and dangerous. 
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With the coming of room borne innovations like-Remote Sensing (RS) and Geographic Data 

System (GIS) it is presently conceivable to screen such blocked off spots all through the year. 

With further increment of remote detecting stages with improved spatial and worldly goals 

help customary perception and supervision of different properties of high ice sheets scilicet-

ice degree, snow line, position of end, volume, icy mass parity. 
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CHAPTER 2 

REVIEW OF LITERATURE 
 

Glaciers are one of the most important constituent of a hydrological system. Around 10% of 

the world‟s land mass is covered with glacier. Glacier, ice caps and continental ice sheets are 

storage of fresh water, and it corresponds to three-quarter of world‟s total fresh water 

resources. They are unique source of fresh water for agriculture, industry and domestic use, 

an important economic component, yet they constitute serious natural hazards. As glaciers are 

natural component, they are directly affected by small climatic fluctuations at both local as 

well as global level but due to retreat of these glaciers glacial lakes are forming. Some studies 

on those lakes are shown below: 

 

J. Gabriel Campbell et. al (2016): 

They studied about the glaciers and glacial lakes and the potential of glacial lakes outburst 

floods due to global warming in the mountainous region of India, Pakistan and China/Tibet 

for the period of 2002-2015 in the paper named “Inventory of Glaciers and Glacial Lakes and 

the Identification of Potential Glacial Lake Outburst Floods (GLOFs) Affected by Global 

Warming”.. Data he used for his study are inventory of glaciers and glacial lakes are different 

type of satellite images, topographic maps and published maps, field report. Three main 

things are carefully taken (1) Changes in Terrestrial Ecosystems, (2) Human Dimensions of 

Global Change and (3) Climate Change and Variability. For this study he used Landsat 7 

ETM+, IIRS LISS3 images, ASTER images were used. Shuttle Radar Topography Mission 

(SRTM) was used for the 3D applications. for the spatial and attribute database development 

and analysis. After the completion of his study he found that in Pakistan 5218 glaciers were 

identified among them 52 lakes are classified from which the potential threat of glacial lake 

outburst floods. In Sikkim Himalaya region 266 glacial lakes were identified out of which 14 

were potentially dangerous glacial lakes. 

 

Julie Gardellea, Yves Arnauda, Etienne Berthier et. al (2011): 

They studied the evolution of glacial lakes along the Hindu Kush in the Himalayan mountain 

range, India, Nepal, Bhutan region for the period of 1990 – 2009. The data he used for the 

study are selected satellite images acquired between September and November (for the 



15 
 

eastern part) and between June and October (for the western part). For each study site, a 

digital elevation model (DEM) of 2000 from the SRTM (Shuttle Radar Topography Mission) 

had also been downloaded. For this study spectral analysis has been carried out with one of 

the LANDSAT. Four bands in the VNIR and MIR (Middle Infra-Red) of ASTER data is 

used. A slope map is computed with a 3x3 pixels window using the SRTM DEM. In this 

study he found that Eastern sites show the largest glacial lake areas (1.7*10
-
² ha/ha for 

Western Nepal, 1.1*10
-2

 ha/ha Everest and 1.8*10
-2

 ha/ha Bhutan).Hindu Kush lake area has 

continuously decreased, for Garhwal sites, glacial lake expansion remains more or less the 

same in the 2000s and lake expansion rates are increasing in the Everest region. 

 

T. Bolch, M. F. Buchroithner, J. Peters, M. Baessler, and S. Bajracharya et. Al (2005):  

They studied motion glacier and potentially dangerous glacial lakes in the Mt. Everest region 

and Nepal region mountainous range using space borne imagery for the period of 1962 - 

2003. For this study ASTER DTM was generated in order to obtain information about the 

characteristics of the glaciers and their surroundings. Corona KH-4, Landsat MSS, 

Topographic map, Landsat TM, Landsat ETM+ for lake identification. Ikonos for glacier 

velocity. In this study glacial lakes were automatically identified using the Normalized 

Differenced Water Index. Since ASTER lacks a BLUE channel the GREEN channel was 

used instead. The displacement of the features was calculated using SSD3.0 (SAR Software 

Dresden, version 3.0). From this study it is found that proglacial and supraglacial lakes in the 

study region increased from 2 km
2
 in 1962 to nearly 3.5 km

2
 in 2003. Most of the increase is 

due to the development of the Imja Lake which began to grow after 1962 and covered an area 

of more than 0.9 km
2
 in 2003. 

 

K. Babu Govindha Raj, S. N. Remya and K. Vinod Kumar et. al (2009): 

 
They studied the glacial lakes present in the Sikkim Himalayan range and their association 

with the hazards for the period of 1962-2008. For the purpose of his study the data he used 

are CORONA, Landsat MSS, TM and Resourcesat-1 (IRS P6) LISS III satellite data were 

used in this study. Apart from satellite data, ASTER digital elevation data (DEM) were also 

used. Declassified CORONA data of 1962 was used as the base data, it captured information 

of the Earth‟s surface in panchromatic films. Supraglacial lake were identified at the snout of 

the glacier with the help of CORONA data. First occurrence of a separate lake is marked in 

the Landsat MSS data. The glacier boundary was also mapped from Landsat TM and 
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Resourcesat-1 LISS III data. The depth measurements of the lake were carried out using 

ASTER DEM. From the study he found that in 1977, the lake had an aerial extent of 17.54 ha 

and was attached to the glacier terminus. The lake areal extent was also mapped from 

temporal satellite data of 1989, 2002 and 2008. The lake area increased by an extent of 81.1 

ha from 1977 to 2008. The areal extent of the lake was measured as 98.7 ha in 2008. Imja 

glacial lake in Nepal increased from a few small ponds in the 1950s to a single body of water 

with a surface area greater than 0.5 sq. km in 1984. The lake volume is 19.7 million m3 and 

lake depth is 20 m. 

 

Aparna shukla et. al. (2018): 

This study is done in the Sikkim and Eastern Himalaya of India for the period of 1975 to 

2017 using Hexagon, TM, ETM+, and OLI images, respectively. First, a baseline data was 

generated for the year 2000 and then the multi-temporal lake changes were assessed. The 

annual mapping of glacial lakes was also performed for four consecutive years (2014–2017) 

to analyze their nature and occurrence pattern. This study reveals that there is continuous 

increase in the size and number of lakes in the study area. The total area of lakes showed 

rather significant increase of ∼24%, increasing from 25.17 ± 1.90 km
2
 to 31.24 ± 2.36 km

2
 

between 1975 and 2017. 

 

Anil V Kulkarni et. al. (2016): 

This study is done in the Sikkim region glacial lakes and particularly 10 lakes and volume 

estimation is done for the period of 2001 to 2015. For this study COSI-Corr method and 

DEM and depth were used to estimate the bottom topography and overdeepening of the bed. 

To estimate the spatial distribution of ice thickness, the „Topo to Raster‟ tool in ArcGIS was 

used. From this study The total volume of the nine lakes was estimated as 149 ± 26 million 

m
3
 in 2001 and 246 ± 44 million m

3
 in 2015. Therefore, increase in volume of the lakes from 

2001 to 2015 was 97 ± 17 million m
3
. 

 

The accelerated changing of glacier has severe impact on human-being, vegetation patterns, 

natural disaster, water supplies and local climate (UNEP). Glacier length changes indicate the 

global climatic changes. The increasing mass loss and decline in glacier size in mountain and 

other regions contribute to sea level rise. The mass loss and change of length of glacier 

depends up on its geometry, and climatic variation. Various meteorological experiments have 
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shown that the primary source for melting in glaciers is solar radiation, and losses of mass 

balance are due to temperature and precipitation.  

Recently using various ground measurements, remote sensing and aerial photogrammetry a 

global scaled record of glacier is obtained. The trend obtained in this study shows that only a 

few glaciers are advancing. Temperate glacier with large accumulation and mass-balance are 

very active than continental glacier due to want of precipitation. Hence temperate glaciers are 

more sensitive to the changing climate than continental glacier sheets.  

2.1 HIMALAYAN GLACIER STUDY OVERVIEW 

Himalayan glaciers are the largest glacier in central Asia. In Himalayan mountain region, 

glacier covers approximately 30,000 km
2
 which is about 17% of mountain area. Himalayan 

Mountain is located near tropic of cancer and receives more heat from solar radiation over 

any time period than other glaciers.
[6]

 Therefore, Himalayan glaciers are more sensitive to 

climatic fluctuations than other mountain glaciers in the world. Most of the glaciers in this 

region are retreating and only some are advancing or are static causing long-term loss of fresh 

water storage. For example, Pandey et al. had referred to a loss of 20% in surface runoff in 

the Hunza and Shyock Rivers in Karakoram and Hindukush mountains since 1961. The high 

altitude of Himalayan glacier preserves its glacial existence in these mountain areas. Variable 

climatic change and terrain difference resulted into different glacier responses to same 

climatic changes in Himalayan area. The hydro-meteorology and the contribution of 

precipitation due to glaciations are controlled mainly by Indian monsoon and westerly, 

climatic regimes. Since the climate of Indian subcontinent is changing with year the 

formation of glacial lakes is also increasing day by day.
[7]

 With the passing of time the 

number of glacial lakes and size of it are increasing. With this increase there are many 

hazards related to it that can be caused due to presence of glacial lakes. 

2.2 TYPES OF HAZARDS 

2.2.1 Glacier Floods 

Generally, glacier floods represent the largest and most extensive glacial hazard, i.e., the 

hazard with the highest potential for disaster and damage (up to 102 mill. m
3
 break-out 

volume and up to 104 m
3
/s runoff). Glacier floods (in the Himalayas often termed Glacier 

Lake Outburst Floods, GLOF) occur in most glacierzed mountains of the world, e.g., in the 

Andes and in particular in Peru, in the Himalayas, Central Asia and in North America. In 

Switzerland they represent a highly relevant hazard potential as shown by a number of 
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specific detailed studies. Glacier floods are triggered by the outburst of water reservoirs in, 

on, underneath and at the margin of glaciers. Most reservoir types develop slowly and two of 

them can be identified at the surface, a precondition which favors the application of remote 

sensing techniques for monitoring glacial and periglacial lakes. Outbursts of ice-dammed 

lakes are usually caused by mechanisms of dam floatation, enlargement of sub glacial 

drainage channels, or overspill. Ice dams, particularly when formed by ice avalanche deposits 

or by the fractured ice of surging glaciers, can also fail through a sudden break producing 

very high peak discharges. Lakes dammed by cold ice with subglacial permafrost have also 

been observed draining by dam overflow. Outbursts from moraine-dammed lakes can be 

triggered by overtopping, piping, slippage on steep slopes or a combination thereof, 

potentially initiated by an ice/snow jam. Bedrock-dammed lakes are commonly considered as 

safe from failure. However, impact waves from mass movements (e.g., ice avalanches, debris 

flows, rock falls) can cause dam overtopping which then may trigger a flood or debris flow. 

 

Figure 2.2.1 Supraglacial ‘Lago Effimero’ (Photo G. Mortara) 
 

In contrast to glacier floods, whose effects are far-reaching, ice avalanches and the damage 

they cause are generally restricted to densely populated high-mountain regions, especially in 

the Alps. Nevertheless, in combination with other glacial hazards, ice avalanches can cause 
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large-scale disasters. Ice avalanches are often triggered by breaking-off of ice from small and 

steep glaciers. The stability of such hanging glaciers is especially critical at altitudes and 

expositions where the firm is at the melting point due to percolating water. 

            

Figure 3 Deposits From the Ice Avala (https://wikivisually.com/wiki/Avala) 

In such cases, the vertical ice front of a hanging glacier typically consists of cold ice frozen to 

the underlying bedrock, which prevents failures of the ice mass. In fact, the geometry and 

thermal condition of the ice front is likely to be a key factor in the control of the stability of 

hanging glaciers. Disturbance of the equilibrium, e.g., by variations in firn accumulation or 

an increase in air temperature and melt water (possibly induced by climate change) may lead 

to hanging glaciers which are prone to failure. 

Swiss glaciology traditionally plays a strong role in research and experience related to ice 

avalanches, since Switzerland is particularly vulnerable to such hazards. For this reason, 

detailed investigations of steep glaciers have been carried out in Switzerland partially 

accompanied by large-scale monitoring based on aerial photography. Worldwide, it is mainly 

the major ice avalanche catastrophes that draw public attention. 

https://wikivisually.com/wiki/Avala
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2.2.2 Glacier Clad Volcanoes 

On a global level, glacier-clad volcanoes represent a further major glacier-related hazard. For 

instance, lahars (volcanogenic debris flows) can impact downstream areas at a distance of 

more than 100 km. The investigation of glacier-clad volcanoes was intensified and reinforced 

following the eruption of Mount St. Helens in 1980 and the Nevado del Ruiz catastrophe  in 

1985. 

 

      

Figure 2.2.3 Eruption of Popocatepetl Volcano (https://en.wikipedia.org/wiki/Popocat) 

In the case of Mt. St. Helens, glaciers have been found to react more elastically on long-term 

deformation than bedrock. Further studies also showed significant influence of ash cover on 

glacier mass balance and thus glacier changes. Eruption from the Nevado del Ruiz with a 

series of pyroclastic flows and surges melted parts of the summit ice cap and triggered large 

lahars having a total volume of about 9 x 10
7
 m

3
. More than 20,000 people lost their lives in 

the downstream areas. 

Still, there are considerable gaps in the understanding of such hazards and related processes. 

In Mexico, a monitoring program has been focusing recently on the glaciers of Popocatepetl 

volcano since a new eruptive phase has been reached. Glaciers have been affected strongly by 

volcanic activity. Assessments of corresponding hazards have been made but dangerous or 
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inhibited access conditions and the complexity of processes involved make them a special 

challenge. 
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CHAPTER 3 

STUDY AREA 
 

The investigation site is Sikkim a state of India. During the previous occasions Sikkim was 

otherwise called 'Basyul' which signifies 'the shrouded land'. The examination region nearly 

covers the whole Sikkim. The scope longitude of the locale approximates up to 

27°34'27.39"N and latitude is 88°29'6.76"E with geological zone of 7096 km
2
 establishing 

just 0.22% of aggregate land territory of India. Sikkim frames a piece of the Eastern 

Himalaya and it contains the Middle and Greater Himalaya. It has a human populace of 

610,577 according to Census, 2011, which establishes just 0.05% of India's all out populace. 

The state is decently rectangular fit as a fiddle with a most extreme length from north to south 

of around 112 km and the greatest width from east to west of 90 km. The state is encircled by 

one of the most noteworthy mountain ranges from west, north, east and south-east. With 

Nepal to its west, the huge stretches of Tibetan Plateau flanking north east and the southern 

limit lying along India and Bhutan, Sikkim is a land bolted Indian Territory (Joshi H.G). 

The Himalaya in Sikkim has rises going from 300 m to 8,600 m above Mean Sea Level 

(m.s.l.). Just about 66% of its landscape is unendingly secured with snow. Sikkim is a home 

for high mountain pinnacles including the third most noteworthy summit on the planet – Mt. 

Kanchenjunga (8,598 m) which is likewise the most noteworthy point in the nation. 

3.1 CLIMATE 

Sikkim is remarkable in light of the different climatic belts in its overall region. It tends to be 

extensively partitioned into sub-tropical, alpine and temperate zone from south to north 

concerning the altitudinal variety. The variety in elevation is to such an extent that one can 

move in all the climatic belts inside 60 minutes. As precipitation happens consistently, the 

atmosphere is for the most part cold and sticky. Moreover, because of its nearness with Bay 

of Bengal the territory gets substantial precipitation. North locale encounters lesser 

precipitation when contrasted with different regions. During April and May the Pre-monsoon 

(South-West) downpours win and the monsoon occurs from May and ended till the mid of 

October. Wonderful temperate is experienced by the populace possessing the mid and lower 

bit of the state. The high height locale in the extraordinary north experience gnawing cold 

temperature and for the most part stays occupied. 
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In the long periods of June and July the mountains in the north get warmed up making a 

convection cell. A low weight zone is made that draws dampness loaded air from the Bay of 

Bengal. The air chills off as it rises and condenses as downpour. The normal yearly 

precipitation is around 2,500 mm and the scope of precipitation differs from around 100 mm 

to 3,500 mm relying on the height and part of region. The mean yearly precipitation is least in 

Thangu (82 mm) and most extreme in Gangtok (3494 mm). In view of the precipitation 

circulation design, there are two most extreme precipitation territories (I) south - east 

quadrant, counting Mangan, Singhik, Dikchu, Gangtok, and Rongli and (ii) the south - west 

corner counting Hilley. In the middle of these two areas, there is a low precipitation region, 

i.e., Namchi. Precipitation here is about portion of that in the previous zones. Precipitation is 

substantial and well circulated during the months from May to early October. July is the 

wettest month in most of the spots. The intensity of precipitation during the southwest 

rainstorm season diminishes from south to north. 

3.2 FLORA & FAUNA 

The marshes in the south, 250 m to 1500 m, experience a tropical atmosphere; rich vegetation 

for example, figs, shrub, Sal trees and bamboos has been cleared in certain regions for 

cultivating. The calm timberland of oak, chestnut, maple, birch, birch, magnolia and silver fir 

overwhelms between 1500 m and 3500 m. Over 3500 m is the snow-capped zone where 

juniper, cypresses and rhododendrons develop. The interminable snowline lies at 3800 m. 

Lush woods spread 36% of the land; in excess of 4000 types of plant have been recorded in 

Sikkim. More than 600 species of orchids develop in Sikkim, Epiphytal and earthbound sorts, 

in the tropical and calm zones. 35 types of rhododendrons develop in calm and snow capped 

districts, their blossoming from May to August hues slopes. 

Table 3.2.1 Flora & Fauna in Sikkim (Economic survey, govt. of Sikkim) 

Flowering plants:                                         4500 Butterflies:                                                    600+ 

Rhododendrons:                                          36 Mountains and peaks:                                28 

Orchids:                                                         550 Glaciers:                                                        38+ 

Conifers:                                                       16 Rivers and streams:                                    104+ 

Tree ferns:                                                    09 Birds:                                                             550 

Primulas:                                                       30 Oaks:                                                             11 

Medical plants:                                            424 Fishes:                                                          48 

Bamboo:                                                       28 Lakes and wetlands:                                  227 

Ferns and ferns allies:                                362 Mammals:                                                   158 
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Figure 3.1 Sikkim Map (https://www.mapsofindia.com/sikkim/) 

 

 

https://www.mapsofindia.com/sikkim/
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Figure 3.2 SOUTH LOHNAK LAKE (27°56’51”N 88°20’01”E) 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3 ECONOMIC IMPORTANCE OF GLACIAL LAKES 

Ice sheets framed lake bowls by gouging gaps in free soil or bedrock, by keeping material 

crosswise over streams beds, or by leaving covered pieces of ice whose dissolving molded 
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lake bowls. All the more as of late, people and different creatures have made lakes and stores 

by damming waterways and streams. 

Lakes continually experience transformative change, mirroring the progressions that happen 

in their watersheds. Most are bound to fill in with survives from lake living beings and with 

sediment and soil washed in by floods and streams. These slow changes in the physical and 

synthetic parts of a lake influence the advancement and progression of plant and creature 

networks. This normal procedure takes a great many years. Human exercises, be that as it 

may, can significantly change lakes, regardless, in only a couple of years. 

Sikkim, a little state in the Eastern Himalaya has just regular inland wetlands having a place 

with the class lakes/lakes. The state has near 300 high elevation lakes which are essentially 

little and shallow. A large portion of it are nourished by icy masses and considered holy. The 

lakes are famously called as Chhokhaor Tsoor Chhona (in Bhutia), Chho (in Lepcha) and 

Pokhari or Jheel or Tal (in Nepali). The eastern piece of the state has novel structure of 

flower conveyance and faunal predominance. The whole lap of the Himalaya has abundant of 

water bodies as new water lakes credited by the ice sheets and perpetual snow topped 

mountains. 
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CHAPTER 4 

DATA SOURCES 

4.1 LANDSAT 

The Landsat program is the longest-running endeavour for obtaining of satellite symbolism of 

Earth. On July 23, 1972 the Earth Resources Technology Satellite was propelled. This was in 

the end renamed to Landsat. The latest, Landsat 8, was propelled on February 11, 2013. The 

instruments on the Landsat satellites have procured a great many pictures. The pictures, filed 

in the United States and at Landsat getting stations far and wide, are a one of a kind asset for 

worldwide change research and applications in farming, cartography, geography, ranger 

service, provincial arranging, observation and training, and can be seen through the U.S. 

Land Survey (USGS) 'Earth Explorer' site. Landsat 7 information has eight ghostly groups 

with spatial goals going from 15 to 60 meters; the transient goal is 16 days. Landsat pictures 

are generally isolated into scenes for simple downloading. Each Landsat scene is around 115 

miles in length and 115 miles wide (or 100 nautical miles long and 100 nautical miles wide, 

or 185 kilometers in length and 185 kilometers wide). 

 

 

Figure 4.1 Landsat Launches (https://en.wikipedia.org/wiki/Landsat_program) 

4.2 LANDSAT 7 

Landsat 7 is the seventh satellite of the Landsat program. Propelled on April 15, 1999, 

Landsat 7's essential objective is to revive the worldwide file of satellite photographs, giving 

cutting-edge and sans cloud pictures. The Landsat Program is overseen and worked by the 

https://en.wikipedia.org/wiki/Landsat_program
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USGS, and information from Landsat 7 is gathered and disseminated by the USGS. The 

NASA World Wind task permits 3D pictures from Landsat 7 and different sources to be 

unreservedly explored and seen from any point. The satellite's sidekick, Earth Observing-1, 

trailed by one moment and pursued the equivalent orbital qualities, yet in 2011 its fuel was 

exhausted and EO-1's circle started to degrade. Landsat 7 was worked by Lockheed Martin 

Space Systems Company. NASA will attempt to refuel it in 2020. 

4.2.1 Specification 

Landsat 7 was intended to keep going for a long time, and has the ability to gather and 

transmit up to 532 pictures for every day. It is in a polar, sun-synchronous circle, which 

means it filters over the whole earth's surface. With an elevation of 705 kilometers +/ - 5 

kilometers, it takes 232 circles, or 16 days, to do as such. The satellite weighs 1973 kg, is 

4.04 m long, and 2.74 m in width. In contrast to its ancestors, Landsat 7 has a strong state 

memory of 378 gigabits (approximately 100 pictures). The fundamental instrument on board 

Landsat 7 is the Enhanced Thematic Mapper Plus (ETM+). 

4.2.2 Main features 

 A "15 m (49 ft)" spatial resolution panchromatic band (band 8) 

 Visible (reflected light) bands with 30 m (98 ft) of spatial resolution (bands 1-

5, 7) in the blue, green, red, near-infrared (NIR) and mid-infrared (MIR) range. 

 A 60 m spatial resolution heat infrared channel (band 6) 

 Full opening, complete radiometric calibration of 5 percent 

Table 4.1.1 Landsat 7 Bands properties 

BAND SPECTRAL 

WAVELENGTH(µm) 

DESCRIPTION GROUND 

RESOLUTION 

BAND 1 .415-.515 BLUE 30m 

BAND 2 .525-.605 GREEN 30m 

BAND 3 .63-.69 RED 30m 

BAND 4 .75-.90 NEAR IR 30m 

BAND 5 1.55-1.75 SHORTWAVE IR 30m 

BAND 61 10.40-12.5(low gain TIR) THERMAL IR 60m 

BAND 62 10.40-12.5(high gain TIR) THERMAL IR 60m 

BAND 7 2.09-2.35 SHORTWAVE IR 30m 

BAND 8 .52-.90 PANCHROMATIC BAND 15m 
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4.3 LANDSAT 8 

Landsat 8 is a satellite started on February 11, 2013 for American Earth observation. It is the 

eighth Landsat satellite, the seventh to effectively achieve orbit. This is a cooperation 

between NASA and USGS, originally called the Landsat Data Continuity Mission (LDCM). 

NASA‟s Goddard Space Flight Center in Greenbit, Maryland development mission systems 

engineering and launch car acquisition while the USGS supplied ground systems 

development and will perform continuing mission activities. 

The satellite was built by Orbital sciences Corporation, who served as the mission‟s prime 

contractor. The tools of the spacecraft were built by Ball Aerospace and the Goddard Space 

Flight Center of NASA, and its launch was ordered by the United Launch Alliance. 

LDCM was checked out and verified by NASA during the first 108 days in orbit and 

operation were transferred from NASA to USGS on 30 May 2013 when LDCM was 

officially renamed LANDSAT 8. 

4.3.1 Specification 

 Collect and archive resolution (30- meter spatial resolution) multi spectral picture 

information providing seasonal coverage of worldwide land masses for at least 5 

years; 

 Ensure that Landsat 8 information is adequately compatible with previous Landsat 

missions information in terms of procurement geometry, calibration, coverage 

features, spectral features, output product quality, and information accessibility to 

allow land cover research and land use changes over time ; 

 Distribute Landsat 8 information products in a non-discriminatory manner to the 

general public at no price to the consumer. 
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Table 4.2.1 Landsat 8 Band Properties 

BAND SPECTRAL 

WAVELENGTH(µm) 

DESCRIPTION RESOLUTION 

BAND 1 .43-.45 COASTAL AEROSAL 30m 

BAND 2 .45-.51 BLUE 30m 

BAND 3 .53-.59 GREEN 30m 

BAND 4 .64-.67 RED 30m 

BAND 5 .85-.88 NEAR INFRARED 30m 

BAND 6 1.57-1.65 SWIR 1 30m 

BAND 7 2.11-2.29 SWIR 2 30m 

BAND 8 .50-.68 PANCHROMATIC 15m 

BAND 9 1.36-1.38 CIRRUS 30m 

BAND 10 10.60-11.19 THERMAL IR 1 100m 

BAND 11 11.50-12.51 THERMAL IR 2 100m 
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CHAPTER 5 

METHODOLOGY 
 

5.1 ANALYSIS OF SATELLITE DATA 

Using satellites namely Landsat 8 and Landsat 7, data was gathered from the USGS scheme 

and analyzed using ArcGIS 10.1. Steps engaged in the glaciers ' general evaluation are 

described below. 

5.2 DATA COLLECTION 

Medium resolution satellite sensors like LANDSAT enable glacier outline to be extracted at 

regional scales using semi-automated algorithms. In the visible (VIS) and near infrared (NIR) 

bands of the electromagnetic spectrum (.35-2.5 µm), optical sensors detect solar radiation 

reflected by the Earth's surface. Radiation emitted by the thermal infrared (TIR) surface (8-

14µm) is registered by the sensor as brightness temperature. LANDSAT, together with 

ASTER, is one of the most frequently used glacier parameter monitoring tools due to its 

appropriate spatiotemporal and spectral resolution, low cost and close to worldwide coverage. 

Remote sensing information in the form of a digital elevation model is freely accessible on 

the U.S. Geological Survey (USGS) website and can be accessed either by choosing the 

coordinates or by the place name. Select the time period from which to collect the 

information. 

LANDSAT 8 and LANDSAT 7 are the sources of the pictures or information acquired, these 

pictures are downloaded using the USGS scheme. We should filter the information using 

months while downloading the picture and the following three requirements should be met: 

 Minimum snow- At the end of the ablation period, specify a time frame. 

 Minimal Clouds-Cloud coverage should be less than 10 percent of the data to be 

downloaded. 

 Adequate contrast-Sensors are saturated in the visible bands, therefore low gain 

settings are suggested in those bands. 

The images downloaded are regarded using ArcGIS in the form of distinct layers according to 

the satellite bands. Information is collected using the software's various instruments. The 

image is downloaded in the format of .tiff. 
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2000, 2005, 2010, 2012, 2016, 2017 and 2018 data are downloaded. The 2016, 2017 and 

2018 data are from Landsat 8, while all other year data are from Landsat 7. Data management 

is also an important part of the project; with their name, data should be saved in different 

folders with proper classification. 

5.3 ADDING DATA IN ARCMAP 

The information gathered from the USGS scheme is stored in separate folders with correct 

classification as required. Data-containing folder contains various bands of data based on the 

satellite used; it might be LANDSAT 8 or LANDSAT 7. If the information acquired is from 

LANDSAT 7 then there will be 8 no bands and if it is LANDSAT 8 then there will be 11 

bands. 

Landsat 7's most significant band is band 5, 4, 3, and Landsat 8's band 6, 5, 4. The folder 

includes 1-11 bands of Landsat surface reflection and the metadata file. Each band is supplied 

as an picture of 16-bit grayscale. 

Start a fresh blank ArcMap document and press the menu key to add it. Add only bands from 

the information folder that are the most significant band 2 to 6. Then load the map with band 

4, 5, 6. Different ArcMap will be introduced to load all the varying years of information. 

5.4 CREATING FALSE COLOUR COMPOSITES 

The display colour assignment for any band of a multispectral image can be done in an 

entirely arbitrary manner. In this case, the colour of a target in the displayed image does not  

have any resemblance to its actual colour. The resulting product is known as a false colour 

composite image. There are many possible schemes may be more suitable for detecting 

certain objects in the image. 

A very common false colour composite scheme for displaying a SPOT multispectral image is 

shown below: 

R = XS3 (NIR band) 

G = XS2 (red band) 

B = XS1 (green band) 
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This false colour composite scheme allows vegetation to be detected readily in the image. In 

this type of false colour composite images, vegetation appears in different shades of red 

depending on the types and conditions of the vegetation appears in different shades of red 

depending on the types and conditions of the vegetation, since it has a high reflectance in the 

NIR band (as shown in the graph of spectral reflectance signature). 

Clear water appears dark-bluish (higher green band reflectance), while turbid water appears 

cyan (higher red reflectance due to sediments) compared to clear water. Bare soils, roads and 

buildings may appear in various shades of blue, yellow or grey; depending on their 

composition. False colour composites (FCC) are useful to get a look at the terrain. Colour 

composite of layer 654 is created. The “composite bands” tool in the Arc toolbox combines 

(stacks) the multiple bands into the single raster dataset. There is a stepwise procedure to 

create FCC in ArcGIS. 

5.4.1 Steps Performed For Creating False Colour Composite 

Launch Arc toolbox then select → Raster → Raster Processing → Composite Bands. 

Input Raster: choose band 6, 5 and 4 one by one for Landsat 8 and band 5, 4 and 3 for 

Landsat 7 in a sequence. 

 

Output Raster: FCC_654.tif and navigate to the folder and save it there, do not change the 

root name, so as to avoid any confusion later. 

 

For clouds add band 5 separately to the map and notice that clouds will be bright in this band 

this is because of spectral differences of clouds vs. ice/snow in near IR. The reflectivity of 

ice/snow drops in the NIR, while clouds are highly reflective in the near-IR. This is visible on 

band 5- ice/snow is black, and clouds are white. Band 5 can be used to mask clouds using 

thresholds the need to be selected on each satellite image. 
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Figure 5.4.1 FCC of Sikkim of Year 2018 

5.5 BAND RATIO METHOD 

A band ratio is a new channel of data created by the division of two sets of band digital 

numbers for each pixel. It means dividing the pixels in one band by the corresponding pixels 

in a second band. The reason for this is twofold: One is that differences between the spectral 

reflectance curves of surface types can be brought out. The second is that illumination, and 

consequently radiance, may vary, the ratio between an illuminated and a not illuminated area 

of the same surface type will be the same and thus this will aid image image interpretation. 

This creates a new set of data that may be used to highlight certain features. Logically, 

rationing may cancel out or reduce whatever is common in two images and exaggerate where 

they are different. Advantage of band ratio is that it is fast, simple and robust. 

It also has some disadvantage, vegetation in shadows and shadows of mountains and some 

part of glaciers may be classified as glacial lakes. 
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5.5.1 Steps Performed For Making Band Ratio 

For glacial lakes Normalized Difference Water Index (NDWI) is used as the band ratio. 

In Arc Toolbox choose Spatial Analyst → Map Algebra → Raster Calculator. 

In raster calculator window, for math algebra expression write expression as follows: 

(float (Band 3) – float (Band 5)) / (float (Band 3) + float (Band 5)) 

In Environments set resolution to 30m. 

Name the output as bandratio_5_6.tif and save it in the folder named „band ratios‟ for the 

corresponding year. 

Add the resulting image to the table of contents. The image is a grayscale with snow and ice 

appearing as white. 

 

 

Figure 5.5.2 NWDI of Sikkim of Year 2018 

5.6 FINDING THE THRESHOLD FOR LAKES 

Using the “identify tool” from the main menu and scroll around the image to look for the 

edges of the water ( it is easily distinguished when we pass the threshold from bare land to 

water and values change sharply). 

Image thresholding: Image thresholding (also called as image segmentation) consist of 

dividing an image into segments with similar spectral or texture characteristics, which 
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corresponds to real real features. To find the threshold Identify tool is used and scrolled 

around the image to look for edges of the ice. Recommended values range from 0 to 0.2. 

 

5.6.1 Steps Performed For Finding Threshold 

In Arc Tool Box, choose Spatial Analyst → Map Algebra → Raster Calculator 

To apply threshold, use the Raster Calculator with the expression:bandratio_5_6>X.X, where 

X.X is the threshold achieved from sensitivity analysis. 

Set the output name as bandratio_5_6trX.X.tif so as to keep the track of different tests. 

The output is a binary image with (0) for non- water and (1) for water. Different thresholds 

were tried from 0 to 0.2 and were saved with different names. 

                 

 

Figure 5.6.1 Threshold of NDWI of Sikkim of Year 2018 



37 
 

5.7 IMAGE FILTERING 

Filters are defined as moving, overlapping neighbourhood statics, and are used to improve the 

quality of raster image by eliminating spurious data or enhancing the feature in data. 

After delineation of ice and snow mass, filter is run to remove extraneous bits. Because while 

using band ratio method small lakes are also misclassified as lakes, and filter to remove these 

errors. 

ArcGIS Spatial analyst provides two types of filter: low pass and high pass and both are 

based on focal functions with weighed kernel neighbourhoods. 

 A low pass filter smooth‟s the data by reducing local variation, and works by 

calculating the average (mean) value for each 3x3 neighbourhood with  the Mean 

statistic type of the Focal Statistics functions (or Focal Mean in Map Algebra). The 

effect is that the high and low values within each neighbourhood are averaged out. 

 A median filter gets rid of the smaller, misclassified cells and smooth‟s the data. 

 

5.7.1 Steps Performed For Image Filtration 

Median filter 3X3 kernel size is applied for the assessment. 

Go to Spatial Analyst → Neighbourhood → Focal Statistics 

Input raster: bandratio_5_6trXX.tif 

Output raster: bandratio_5_6trX.Xmed3X3.tif 

Under the “statistics type” drop down menu choose “MEDIAN” and specify a 3x3 

neighbourhood with units as cell. 

In table of content right click on the filtered layer and export raster to save the final copy of 

the classification as lake.tif. 
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Figure 5.7.1 Image Filtration of Sikkim of Year 2018 

5.8 RASTER TO VECTOR CONVERSION 

In this step lakes are converted to polygon so as to calculate the area of lakes in the next step. 

These polygons can also be obtained directly with the data present on the GLIMS site but it‟s 

too complex as it gives the polygon of all the glaciers present on earth and hence area 

calculation for any specific area is very difficult. ArcGIS makes it simple to convert the raster 

into polygon and are easily obtained. 

Steps performed for vector conversion 

In Arc Tool Box, go to Conversion Tools → From Raster → Raster to Polygon. 

Select the best filtered result, med 3X3 is selected as input and output is specified as raster 

lakes_2018_uned.shp and saved in the folder shapefile. Extension used for shape file is .shp. 

The current file contains both the non-ice and ice, gridded by grid code 0 and 1. Polygons are 

edited further to remove the ice. From the main toolbar menu, Editor Toolbox is added and 

the newly created shape files are chosen for editing. 
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5.9 EXTRACTION 

The Extraction tools allowed to extract a subset of cells from a raster by either the cells 

attributes or their spatial location and also to obtain the cells values for specific locations as 

an attribute in a point feature class or as a table. 

The tools that extracted cell values based on their attribute or location to a new raster include 

the following: 

 Extracting cells by attribute value (Extract by Attributes) is accomplished through a 

where clause. 

 Extracting cells by the geometry of their spatial location requires that groups of cells 

meeting a criteria of falling within or outside as specified geometric shape (Extract by 

Circle, Extract by Polygon, Extract by Rectangle). 

 Extracting cells by specific locations requires that you identify those locations either 

by their x,y point locations (Extract by Points) or through cells identified using a 

mask raster (Extract by Mask). 

In this step area required for assessment was extracted from the over layer of the data 

collected from the satellite. In the thesis Sikkim Himalaya was the main point of focus so all 

the nearby area was removed with the help of extraction. Extraction by mask (Extracts the 

cells of a raster that corresponds to the areas defined by a mask) was the method used. Mask 

file was downloaded from the IMD data in the form of shapefile for Sikkim region. 

Extraction was done for getting the extracts for FCC, band ratio, threshold, filter and polygon 

images. Raster obtained after the extraction was used in calculating the area of all the 

polygons present in the focussed region. Extraction is basically done for getting the desired 

area on which we have to perform the study. The data or satellite images obtained from 

USGS are of larger area and study to be done is for specified areas. 

5.9.1 Steps Performed For Extraction  

In Arc Toolbox → Spatial Analyst Tool → Extraction → Extract by map. 

Input Raster: bandratio_5_6trX.Xmed3X3.tif 

Feature Mask Data: SikkimIMD.shp 

Output Raster: bandratio_5_6tr_extract.tif 

All these steps were performed to get the extracted raster‟s of all the images formed through 

various above mentioned steps. 
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Figure 5.9.1 Extraction of Sikkim Lakes of Year 2018 

 5.10 AREA CALCULATION 

Area is calculated from the polygons formed in the previous step. Area is calculated 

separately for all the years: 2000, 2005, 2010, 2012, 2016, 2017 and 2018. Calculation of 

area is the main objective of the work and then comparison is done on the basis of area 

change during these years. 

Area is calculated with the help of specific functions of Arc Toolbox and used to calculate the 

area of all the polygons present in the Arc map. 

 

5.10.1 Steps Performed For Area Calculation  

In Arc toolbox → Utilities → Calculate area. 

Input Raster: glaciers_2017_uned.shp 

Output Raster: area_lakes_2017.shp 

Then right click on the newly generated area file, choose the option editor toolbox → start 

editing then go back and click on :open attribute table” and new dialog box will open with list 
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of all the lakes along with their lakes id and grid code. Grid codes are given as 0 and 1, the 

one with 0 are needed to be removed as they give the area which are not lakes. 

In attribute table select the option “select by attribute” and select the “GRIDCODE” and 

write = 0, all the GRIDCODE with 0 will be automatically selected and apply this editing 

features and press “delete” all the lakes with grid code 0 will be deleted. 

Export this attribute table to excel, in the form of text file and add the area of all the 

polygons. 

                   

Figure 5.10.1 Area of Glacial Lakes of Sikkim of Year 2018 

5.11 ANALYSIS OF METEOROLOGICAL DATA 

“Climate change” in the context of the intergovernmental climate change panel refers to a 

climate change that can be identified by changes in the mean and/or variability of its 

properties and that persists for an extended period of time, typically decades or longer. It 

relates to any climate change over time, either because of natural variation or because of 

human activity. As per the Climate Change Use Framework Convention of the United 

Nations, it relates to climate change that directly or indirectly attributes to human activity that 

alters the structure of the global atmosphere and is in relation to the natural climate variability 

observed over similar periods of time. Meteorological information plays a major role in 

glacier formation and ablation. The primary variables responsible for the modifications in 
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glaciers are temperature and precipitation. Global warming is the primary factor for the rapid 

melting and retreat of glaciers in the Sikkim Himalayas. 

In latest decades, climate variability has had significant effects on the lifecycle of the glacier 

in the Himalayan region. Many Sikkim Himalayan glaciers are leaving glacial lakes with 

growing intensity, which is in reality confirmed by the majority of researchers with the long-

term impacts of climate change. Thinning and retreating glaciers in the Sikkim Himalayas led 

in the creation of fresh glacial lakes and the expansion of current ones owing to the 

accumulation of melt water behind loosely consolidated end moraine dams. Recent surveys 

conducted by Advanced Computing Development Centre (C-DAC), Pune and Sikkim State 

Council of Science & Technology, Gangtok, have shown that many natural lakes in the 

Sikkim Himalayan area have grown over the years revealing the effect of climate change on 

natural lakes and related dangers. 

5.11.1 Steps Performed For Temperature And Rainfall Analysis 

Temperature and rainfall information were acquired from the IMD site for an annual average 

period of 35 years from 1966-2000 and the graph was designed to observe rainfall and 

temperature variations during this period as the new variables play a very significant part in 

changing the region of glacial lakes. 

5.11.2 Temperature Analysis  

Data from the Indian Meteorological Department were gathered from 1966 to 2000 and 

graphs were used to observe the shift in mean mean rainfall and mean mean temperature. A 

chart has been plotted for each month and year to check or analyze the annual mean annual 

mean precipitation mean temperature change. 
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Figure 5.11.1 Temperature Variation Graph of JAN from 1966-2000 

The minimum temperature was in 1983 was 6.5° C, while the maximum temperature was in 

1999 was 10.5° C and the average temperature in that period was 8.41° C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.2 Temperature Variation Graph of FEB from 1966-2000 

The minimum temperature was in 1985 was 6.75° C, while the maximum temperature was in 

1999 was 14.55° C and the average temperature in that period was 9.77° C. 
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Figure 5.11.3 Temperature Variation Graph of MAR from 1966-2000 

The minimum temperature was in 1990 was 11.2° C, while the maximum temperature was in 

1999 was 15.75° C and the average temperature in that period was 13.51° C. 

 

 

 

 

 

 

 

 

 

Figure 4 

Figure 5.11.4 Temperature Variation Graph of April from 1966-2000 

The minimum temperature was in 1986 was 13.5° C, while the maximum temperature was in 

1999 was 18.75° C and the average temperature in that period was 16.29° C. 
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Figure 5.11.5 Temperature Variation Graph of MAY from 1966-2000 

The minimum temperature was in 1986 was 13.5° C, while the maximum temperature was in 

1999 was 18.75° C and the average temperature in that period was 16.29° C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.6 Temperature Variation Graph of JUNE from 1966-2000 
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The minimum temperature was in 1986 was 17.2° C, while the maximum temperature was in 

1998 was 20.2° C and the average temperature in that period was 19.14° C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.7 Temperature Variation Graph of JULY from 1966-2000 

The minimum temperature was in 1986 was 17.1° C, while the maximum temperature was in 

1998 was 21.5° C and the average temperature in that period was 19.39° C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.8 Temperature Variation Graph of AUG from 1966-2000 
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The minimum temperature was in 1986 was 17.9°C, while the maximum temperature was in 

1994 was 20.1° C and the average temperature in that period was 19.4°C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.9 Temperature Variation Graph of SEP from 1966-2000 

The minimum temperature was in 1986 was 16°C, while the maximum temperature was in 

1994 was 19.4°C and the average temperature in that period was 18.5°C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.10 Temperature Variation Graph of OCT from 1966-2000 
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The minimum temperature was in 1986 was 13.1°C, while the maximum temperature was in 

1998 was 18.3°C and the average temperature in that period was 16.6°C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.11 Temperature Variation Graph of NOV from 1966-2000 

The minimum temperature was in 1985 was 10°C, while the maximum temperature was in 

1998 was 15.7°C and the average temperature in that period was 13.2°C. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.12 Temperature Variation Graph of DEC from 1966-2000 
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The minimum temperature was in 1986 was 7.5°C, while the maximum temperature was in 

1998 was 12.5°C and the average temperature in that period was 10°C. 

 

 

 

 

 

 

 

 

 

Figure 5.11.13 Annual Temperature Variation Graph from 1966-2000 

The minimum temperature was in 1986 was 12.9°C, while the maximum temperature was in 

1998 was 16.4°C and the average temperature in that period was 15.1°C 

5.11.3 Rainfall Analysis 

Rainfall data from the IMD system for the years 1966 to 2000 have been downloaded. Graphs 

are plotted separately for all the various months and years to analyze the rainfall variation. 

 

 

 

 

 

 

 

 

Figure 5.11.14 Rainfall Variation Graph of JAN from 1966-2000 
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 The minimum rainfall was observed in 1969 as 0mm, while the maximum value of rainfall 

was observed in 1975 as 80.1mm and the average rainfall was 36.4mm during this time. 

 

 

 

 

 

 

 

 

Figure 14 

Figure 5.11.15 Rainfall Variation Graph of FEB from 1966-2000 

The minimum rainfall was observed in 1969 as 1.2mm, while the maximum value of rainfall 

was observed in 1975 as 507.6mm and the average rainfall was 79.4mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.16 Rainfall Variation Graph of MAR from 1966-2000 
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The minimum rainfall was observed in 1979 as 4.3mm, while the maximum value of rainfall 

was observed in 1968 as 263.9mm and the average rainfall was 122.1mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.17 Rainfall Variation Graph of APRIL from 1966-2000 

The minimum rainfall was observed in 1989 as 81.5mm, while the maximum value of rainfall 

was observed in 1999 as 504.8mm and the average rainfall was 270.9mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.18 Rainfall Variation Graph of MAY from 1966-2000 
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The minimum rainfall was observed in 1970 as 309.6mm, while the maximum value of 

rainfall was observed in 1983 as 906.7mm and the average rainfall was 527.6mm during this 

time. 

 

 

 

 

 

 

 

 

 

Figure 5.11.19 Rainfall Variation Graph of JUNE from 1966-2000 

The minimum rainfall was observed in 2000 as 299.3mm, while the maximum value of 

rainfall was observed in 1997 as 1281.2mm and the average rainfall was 611.3mm during this 

time. 

 

 

 

 

 

 

 

 

 

Figure 5.11.20 Rainfall Variation Graph of JULY from 1966-2000 
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The minimum rainfall was observed in 1984 as 3809mm, while the maximum value of 

rainfall was observed in 1967 as 788.5mm and the average rainfall was 628.5mm during this 

time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.21 Rainfall Variation Graph of AUG from 1966-2000 

The minimum rainfall was observed in 1996 as 239.7mm, while the maximum value of 

rainfall was observed in 1984 as 1088.2mm and the average rainfall was 563.21mm during 

this time. 

 

 

 

 

 

 

 

 

 

Figure 5.11.22 Rainfall Variation Graph of SEP from 1966-2000 
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The minimum rainfall was observed in 1996 as 188mm, while the maximum value of rainfall 

was observed in 1970 as 848.3mm and the average rainfall was 463.3mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.23 Rainfall Variation Graph of OCT from 1966-2000 

The minimum rainfall was observed in 1970 as 17.3mm, while the maximum value of rainfall 

was observed in 1996 as 488mm and the average rainfall was 177.8mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.24 Rainfall Variation Graph of NOV from 1966-2000 
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The minimum rainfall was observed in 1996 as 0.2mm, while the maximum value of rainfall 

was observed in 1995 as 173.5mm and the average rainfall was 41.6mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.25 Rainfall Variation Graph of DEC from 1966-2000 

The minimum rainfall was observed in 1968 as 0mm, while the maximum value of rainfall 

was observed in 1977 as 83.8mm and the average rainfall was 21.1mm during this time. 

 

 

 

 

 

 

 

 

 

 

Figure 5.11.26 Annual Average Rainfall Variation Graph from 1966-2000 
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The minimum rainfall was observed in 2000 as 197mm, while the maximum value of rainfall 

was observed in 1974 as 353.6mm and the average rainfall was 269.2mm during this time. 
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CHAPTER 6 

RESULTS & DISCUSSIONS 
 

This study highlights the assessment of lakes present in the Sikkim Himalayan region for 

possible inferences of global climate change impacts in high mountains like the Himalaya. 

The study has been done with the help of remote sensing data obtained from Landsat 

Thematic Mapper and Indian Remote Sensing (IRS) satellite images. Data has been obtained 

from USGS (United States Geological Survey) system named Earth explorer for the year 

2000, 2005, 2010, 2012, 2016, 2017 and 2018. Area for all the years has been calculated by 

performing various tasks in ArcGIS. 

The total glacial lakes area was observed as 8.49 Km
2
 in 2000, 8.91 Km

2
 in 2005, 9.95 Km

2
 

in 2010, 12.78 Km
2
 in 2012, 17.2 Km

2
 in 2016, 18.9 km

2
 in 2017 and 19.6 Km

2
 in 2018. 

With the area calculated for all the years it is observed that with the passage of time area of 

glacial lakes in the Sikkim Himalayan region is continuously increasing. The area coverage 

of glacial lakes increased during the period of 2000 to 2018. The overall area of glacial lakes 

in the Sikkim region was 31.24 ±2.36 km
2
 as reported by Aparna et.al. till 2017. The 

percentage change in the area of glacial lakes is 3.77% during 2017 to 2018 whereas the 

overall change in the area of glacial lakes from 2000 to 2018 is 130.8%( i.e 11.11 Km
2
). 

Glacial lakes area is increasing in size year by year because the falling snow is not able to 

replace the melting of ice. Since glacial lakes are one of the most reliable climate indicators 

which indicated the change in the climate could be due to anthropogenic activities. 

Table 6.1 Glacial Lakes Area 

YEAR AREA (Km
2
) 

1965 5.627 (Kulkarni et al. 2010) 

1976 6.073 (Kulkarni et al. 2010) 

1989 7.874 (Kulkarni et al. 2010) 

1997 8.37 (Kulkarni et al. 2010) 

2000 8.49 (this study) 

2005 8.91 (this study) 

2010 9.95 (this study) 

2012 12.78 (this study) 

2016 17.2 (this study) 

2017 18.9 (this study) 

2018 19.6 (this study) 
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Glaciers are the coolers of the planet earth and as the study shows that glacial lakes area are 

increasing which means glaciers area are decreasing and that is not good for our natural 

environment and for the human race as it also hinders the environment and brings many 

natural disaster with them. The number and area of glacial lakes are shown in the table above.  
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CHAPTER 7 

CONCLUSION 
 

Area of glacial lakes in the Sikkim Himalayan region was calculated for years 2000, 2005, 

2010, 2012, 2016, 2017 and 2018. Landsat data was used to carry out the study. Automatic 

delineation methods were used to derive the results. As per the results of the study, the region 

has shown to have gain 130.8% of area from 2000 till 2018. Results calculated might vary 

with actual situation of depletion of area. The variation might occur as per resolution problem 

in data, presence of debris presents in the glacial lakes, the shadows of the mountains and 

cloud cover (which could not be classified very efficiently). 

Since temperature and rainfall plays a very significant role in changing in climatic conditions 

and these climatic changes are responsible for increase in area of glacial lakes. So, 

temperature and rainfall data taken from IMD website was analysed for years 1966-2000. The 

average value of temperature from 1966-2000 was found to be 15.1 whereas the average 

value of rainfall from 1966-2000 was found to be 269.22 mm. The observed value of 

temperature was found to be very less as compared to temperature values now a days, 

„Industrial revolution‟ is mentioned as the main cause of this rise in average temperature in 

many researches done earlier. 

According to the results given out by World Glacier Monitoring Service, the UN 

Environment programme declared that around the world glaciers are melting rapidly which in 

turn cause in increase in the size of glacial lakes. Mainly recent research had revealed that the 

average rate of formation in the area of glacial lakes had increased and it is definitely a major 

cause of concern for whole world. It had been observed in the research that glacial lakes area 

have increased over the past centuries. The prime reason for this increase in area of glacial 

lakes is rapid industrialisation which in turn has caused global warming is the prime culprit of 

formation of these glacial lakes. 

Formation of these glacial lakes and increase in the area of these glacial lakes can cause the 

stream and rivers to overflow and also a huge deposition of the melted water is getting 

accumulated in the mountainous region, which will outburst when this melted water will 

cross its certain limit. These GLOFs are very dangerous and can occur at any time in future. 
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This thesis is a kind of warning for all of us to anyhow control the cause of global warming, 

so as to preserve the nature and control the adverse climatic changes in the atmosphere. 

Government as well as individual should work at their levels to control pollution which is 

directly or indirectly responsible for global warming. 
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